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2. Introduction 
 

 Bf Bot Manager is software used for automated betting or trading at Betfair exchange and it is 

official Betfair API solution since February 2009. Beside fully automated bots Bf Bot Manager also has 

tools and controls for manual betting (like Ladder/Grid controls) and for keeping notes and reminders 

about user selections (Bf Notes add-on). 

 This document explains general options and components of Bf Bot Manager that are available 

for use regardless of selected bot. Some parts of components explained in this document are only 

available within one of Bf Bot Manager versions. For tutorials and manuals about bots that are available 

within Bf Bot Manager please see Resources section of this document. 
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3. Menu 
 

 Main menu of Bf Bot Manager is displayed on Image 1. Menu items “View” and “Tools” will be 

explained in their own sections in this document, while “Bf Notes” functionality is explained in its own 

document that explains “Bf Notes” add-on. “Help” menu item has sub items “Check for update” and 

“About” that are used to check for new update and to view information about currently installed version 

of Bf Bot Manager and license information for local machine. 

Image 1 

 

 

3.1 View 
 

 Under “View” menu item we have access to forms that are used for viewing data that is 

generated by running bots.  

Image 2 

 

 

3.1.1. Bets 

 

 Bets form, displayed on Image 3, is used for viewing bets that were placed by currently running 

bot. When bot gets stopped then this list of bets is cleared. Only bets for current bot session are 

displayed on this form. For all time bets that were placed by any bot you should use “Bets History”. 

 Information displayed on this form contains event, market and selection name (with start time 

of that market), bet status, bet size, bet price, bet type, profit and loss of bet, placed time and bet id. 

From version 2.0 of Bf Bot Manager this form also has buttons “Settle as win” and “Settle as loss” that 
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allow user to settle bets manually if needed. You should always settle first losing bets and then winning 

ones! 

 Total profit and loss of all bets from this form is displayed in bottom left corner. Bets are 

displayed in order of placed time, on top go last bets while the first ones that were placed are at the end 

of grid. 

Image 3 

 

 

3.1.2. Requests Information 

 

 Requests information form, displayed on Image 4, is used for displaying number of made 

requests to Betfair Free API. At this form we can see exact number of made requests for each type of 

request.  

 First column contains internal request name, second column displays total number of those 

requests, third column displays number of successful requests and last column displays number of failed 

requests. 

  If number of failed requests is high (more than 50 for one type of request) then recheck your 

internet connection and make sure that it is working properly. It is also possible that requests fail 

because Betfair web site is unavailable due to maintenance, you can check this by going to Betfair web 

site and check for their API status at their forum. 

 At bottom of this form we can see time when software was started and total time since start. 

Below this is displayed number of requests that are waiting to be executed and this number should 
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never be more than 10. If number of requests waiting to be executed is more than 10 then something is 

wrong, either your internet connection is too slow or Betfair API is unavailable. 

Image 4 

 

 

3.1.3. Bets History 

 

 Bets history form, displayed on Image 5, is used for viewing all bets that were placed by Bf Bot 

Manager. This list includes complete bet information and even more. 

 Beside basic bet information we can also see name of bot that placed bet, total amount of 

money matched on market, number of runners, loss recovery amount and indicator if the bet was 

simulated or real. 

 Bets can be filtered by exchange (UK or AU), time range and bot name. When search is used 

then values at bottom of this form are automatically updated to indicate number of bets, profit and loss, 

strike rate, total stake and total loss recovery for returned bets by search. 
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 Bets get added to the history when they are settled and by default this happens once per 

minute. In case that bet is not added to history or if bet has Matched status, then you can use “Tools-

>Update missing bets information’s” menu item to update status and data for those bets. 

 As you keep using Bf Bot Manager and placing bets, number of bets in history will increase and 

you will want to remove old bets from history. You can do this by using remove menu items under 

“Tools” menu item. You have menu items to remove all bets, bets without information or bets for last X 

days. You can also manually select records in grid and use option “Tools->Remove Selected Records” to 

remove only selected records. 

 In case that you want to export and save your bets you can use “File->Export” menu item and 

bets with all information will be exported to CSV file. Separator for this export can be set in bottom right 

corner of this form, by default comma is used as separator.  

Image 5 

 

 

3.1.4. All Markets 

 

All markets form used to list all Betfair markets sorted by total amount of matched money. You 

can filter markets by event type and see which market is Betfair start price market and which markets 

will go in play. Date and time, market id and menu path are displayed for each market. Clicking on menu 

path will open Betfair market in browser.  
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Image 6 

 

 

3.2 Tools 
 

 Tools section is used for components that can be changed and have effect on the way Bf Bot 

manager works. Changing any of those options can have large effects on how software is performing, so 

if you are unsure about changes that you are making then please contact us and we will help you. 

Image 7 

 

 



 

9 
  

©2008-2015 http://www.bfbotmanager.com 

3.2.1. Log File 

 

 Log file menu item will open log, like on Image 8, that is created by Bf Bot Manager and to which 

bots and Bf Bot Manager write report messages and errors if they happen. If you find any problems with 

software then you should immediately open log file, save its content and send it to us if needed to fix 

the error that happened.  

Image 8 

 

3.2.2. Proxy 

 

 Proxy server is used when making requests to Betfair server. You should not use proxy server 

unless really needed. For more information on proxy servers please visit following Wikipedia page 

http://en.wikipedia.org/wiki/Proxy_server 

 Setting wrong details for proxy server can cause Bf Bot Manager to stop working because it will 

be unable to communicate with Betfair API. 

http://en.wikipedia.org/wiki/Proxy_server
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Image 9 

 

 

3.2.3. Results 

 

 Results service is used for saving collected results for markets that are loaded to main markets 

data grid view by bots that you run. This does not have any effect on the way bots work and this service 

can be started or stopped by clicking on “Start/Stop” button or by ticking “Auto start service for saving 

results on startup” option at “Tools->Options” form, like on Image 10. 

 Time to record odds for winning selection and amount of data that can be saved can also be set 

at “Tools->Options” form. Results can be exported to CSV file if you need to analyze them in Excel or 

some other software. 

 Main results form allows user to filter results by date range, market type (sport) and to set 

filters for market name. For example, you can set to display only results for horse races where market 

name contains text “Hcap” if you want to get results for Handicap races. 

 Favorite wins statistics is displayed in bottom right corner and those values are updated 

whenever “Search” button is clicked. This allows user to select results only for markets on which bot is 

set to bet and to get basic favorite wins statistics for those results or to export them to CSV file and do 

further analysis with some other software. 

 To manually delete results or some specific rows in grid you just need to select them and click 

on “Delete selected rows” button. Rows in grid can be simply selected by clicking on them with left 

mouse button and if you hold CTRL or SHIFT key then you can select multiple rows at once and delete 

them with single click. 
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Image 10 

 

 

3.2.4. Settings 

 

 Global settings form, displayed at Image 11, can be opened by clicking on “Tools->Settings” 

menu item. At this form we have settings that are used by Bf Bot Manager framework and settings that 

are used by some bots. 

 From version 2 of Bf Bot Manager startup form is displayed after login screen, and at this form 

you can pick which bot you want to start. If you do not wish to see this display start up form then you 

can turn off option “Show startup form with bots”. You can also set your preferred bot that will be 

started automatically after login screen. To do this, just tick option “On start, automatically load 

following bot” and pick your bot in combo box below. 

 Some bots are capable of increasing bet size to compensate money lost due to Betfair 

commission. If you want those bots to do this then tick option “Add commission to bet size if possible” 

and set your commission percentage in combo box. You can also turn option “Take commission from 

market profit” that will reduce your overall profit per market for commission, this allows more accurate 

stop bot rule when max profit is reached. When creating screenshots it is strongly recommended to hide 

your account funds and username, to help you do this you can turn on options “Hide username/funds” 

from main bot screen. 
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Image 11 

 

  

 Option “Start recording Min/Max prices X minutes before start time” is used to tell the bot 

when to start recording best market prices that can be used by some bots to determine price 

movement. Bot records market prices that form best overrounds (closest to 100%), but min/max price is 

recorded from time set here regardless of overround. You also have option to record only prices before 

or during in play and option to stop recording prices X minutes before in play or X seconds after going in 

play. Min/max price is recorded only when ratio between Back and Lay price is within your specified 

ratio at this settings form, this is very useful for markets that are not formed properly e.g. US/RSA/AUS 

races few hours before start time only have some bad prices on market so in such cases we do not want 

to record those bad prices as min/max prices. There is also option to clear recorded prices when bet is 

placed so that bot records new prices after bet is placed. Some bots have options to use first recorded 

min/max prices in their logic, for those bots it can be useful to tick option “Record first prices separately 

when starting to record prices”. 
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Image 12 

 

 Bf Bot Manager is using Free API so maximum refresh rate for updating bets and checking if they 

were matched is once per second and maximum refresh rate for getting settled bets is once per minute, 

so default options for this are set to 2 seconds for checking if bets were matched and 60 seconds for 

getting settled bets. It is possible to change those values so that bots make fewer requests to Betfair 

API, but minimum values are 1 second for checking if bets were matched and 60 seconds for getting 

settled bets (those are actually fastest possible refresh rates with Free API). Those refresh rate for bets 

are more than enough for bots that work with Bf Bot Manager. 

 Inferred winner functionality is used to determine winner of market by looking at the odds e.g. if 

odds on selection are less than 1.05 and market gets suspended then that selection is considered as 

winner. This is very useful for getting fast results for horse races so that bets can be placed on next 

market that starts within few minutes. This service does not guarantee to find winner all the time and it 

is not always 100% accurate. To use this service you will need to set market monitor type to until 

“Closed” or until “Suspended for N seconds” so that market gets monitored during in play and until end 

(see more details about market monitor types in section 4.2 Options). 
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Image 13 

 

 

 Void bets if result is not available functionality is useful when race result is not available and 

bets cannot be settled, then bot can consider bets as voided (zero profit/loss) and continue betting 

instead of waiting for result and bets to be settled. Optionally you can set to consider bets as profitable 

or losing bets. This option should be used carefully, because once result is available then bets profit/loss 

will be changed and it might appear that bot did not calculate stakes properly when actually bot worked 

exactly as it was supposed to work. 

 Option to play sound when bet is placed will play “Windows - Exclamation” sound whenever any 

bot attempts to place bet. Option to play sound when market gets suspended will play “whistle” sound 

when market changes its status from Active to Suspended e.g. this happens when goal is scored or when 

market goes in play etc. Bot can also play “Windows – Exclamation” sound when market makes overall 

loss or when each bet makes loss e.g. useful if bot is working in background and you want to be notified 

when bot makes loss on market or bet loses. 
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Image 14 
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4. Main markets data grid view 
 

 Main markets data grid view, displayed on Image 15, is used by almost all bots and its main 

purpose is to monitor and collect information for loaded markets. 

 Currently monitored markets have yellow background in “Start Time” cell, while markets that 

are monitored and in play have green background. Grey background in this column indicates that 

monitoring for that market has finished, while white background indicates that that market will be 

monitored in future when the time comes by settings. 

Image 15 

 

 

 Explanation of each column in markets data grid view follows: 

 “R.” – clicking on button in this column removes market from the list and bets will not be placed 

on that market 

 “S.” – only markets that are selected in this column will be monitored and bot will try to place 

bets on them. Unselected markets will not be monitored so bot will not be able to place bets on 

them. 

 “IP” – gray icon is for markets that will not go in play, orange icon for markets that will go in play 

and green icon is for markets that are currently in play 

 “Start time” – this is local start time of market 

 “Market name” – detailed market name, filters are applied to this value 

 “S.” – market status column, background of this cell will be red when market is suspended, grey 

when it is closed or inactive and white when market is active 

 “1st Favorite” – name of first favorite is displayed in this column unless user set his own favorite 

by using column “Fav.” at selections form 
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 “Winner” – winner or list of winners for market, this information is used by simulation mode to 

settle bets. If there is no winner in this cell then bets cannot be settled in simulation mode. Real 

bets are settled by Betfair and are not affected by results displayed in this cell 

 “Winner(s) Favorite Position(s)” – favorite positions of selection(s) that won the market. 

Favorite positions for those runners are determined by using market prices that are recorded X 

seconds before start time when overrounds were the best. Time to record those prices can be 

set at Tools->Results->Results Settings form. 

 “My Favorites By Position” – for bots that bet by favorite position you may enter in this column 

CSV (Comma Separated Values) list of position on which to bet on e.g. entering “1,3,5” would 

tell bot to bet on First, Third and Fifth favorite by position 

 “Back” – optionally set Back bet type to be used on that market if loaded bot supports this 

option 

 “Lay” – optionally set Lay bet type to be used on that market if loaded bot supports this option 

 “P/L” – overall profit or loss for market 

 “Sl.” – clicking on button in this column opens “Selections Form” that displays list of selections 

for market 

 “Amount @ Back P.” – amount and Back price of selected runners in “1st Favorite” column 

 “Amount @ Lay P.” – amount and Lay price of selected runners in “1st Favorite” column 

 “Back/Lay Over.” – Back and Lay overround for last collected market prices 

 “NOR” – number of runners on market 

 “Score” – available only for football matches if Correct Score market is loaded and monitored. 

Score is determined by using Correct Score market odds, this is not 100% reliable solution but it 

works for most markets that have high traded volume 

 “Total Matched” – total amount of money matched on market 

 “Removed runners” – list of runners that were removed from market and their reduction factors 

 

4.1 Context Menu 
 

 Right click on markets data grid view will open context menu with options for working with 

loaded markets. 

Available options in context menu are: 

 “Check All” – selects checkbox in column “S.” for all markets 

 “Uncheck All” – deselects checkbox in column “S.” for all markets  

 “Refresh” – refreshes layout in grid 

 “My Selections” – opens “Selections Form” with list of “User Bets” 

 “Add Markets” – opens form for adding markets manually to the grid, see section Add Markets 

for more details 
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 “Import Selections” – opens form for importing selections from file, see section Import for more 

details 

 “Export to Excel” – exports markets and their data from grid to CSV file 

 “Export My Favorites – Fav” – exports user favorites that were picked by using “Fav.” column at 

“Selections Form” so that those selections can be loaded later by using import functionality 

 “Columns” – it allows user to show or hide columns in markets data grid view 

 “1st Favorite column displays data for” – allows you to pick position of favorite for which data 

will be displayed in markets data grid view 

 “Options” – opens form with options for monitoring markets loaded in grid, see section Options 

for more details  

 

Image 16 

 

 

4.2 Options 
 

 Options form allows user to changed refresh rates for monitoring and updating market data, 

and also allows user to tell markets data grid view for how long to monitor each market. Those are very 
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important options and they affect the way bot places bets. Those options should be changed only if 

really necessary.  

Image 17 

 

 Here is a brief explanation for each of those options: 

 “Market refresh rate (ms) – refresh rate for getting market prices in milliseconds. Maximum 

(fastest) refresh rate is 1000ms (1 second) 

 “Get market info at start interval (ms)” – grid collects detailed information about each market 

when it gets added to the grid. By default grid gets info for 5 markets per minute.  

 “Get passed markets info interval (ms)” – once detailed information is collected for all markets 

in grid then grid checks one by one market for any changes that might have been made to the 

market since the last time detailed info is collected e.g. checks if market has been closed 

 “Timeout for market to in running” – if market status changes to suspended and market is not in 

play, then if market stays suspended for more than X seconds specified here grid will consider 

that this market will stay suspended for ever and that it will never go in play or be active again 

 “Timeout for getting passed market info (min)” – this is time after which bot will stop checking 

for market status at Betfair after it has stopped monitoring market e.g. if market is Suspended 

and bot is not collecting market prices for it, then after X minutes bot will stop checking for this 
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market status if it has not changed its status to Closed. Market status is displayed in column 

after market name 

 “Start monitoring markets X minutes before start time” – if user has set bot to place bets 2 

minutes before start time then there is no need to start monitoring markets few hours before 

their start time, in such situations it is best to set to start monitoring market 5 minutes before 

start time 

 “Stop monitoring markets before start time” – it will stop monitoring markets X minutes before 

start time, very useful if you are placing bets much before start time and you do not want to 

monitor market after that 

 “Monitor market until” – determines until when grid will monitor market. If you want it to 

monitor market during in play then set this to until “Closed” or until “Suspended for N seconds” 

and set “Monitor market for (sec)” value to 60 

 “Monitor multiple markets at same time” – this forces grid to monitor more than one market at 

a time. This should be used when more than one market starts at same time e.g. soccer 

matches. If you are monitoring horse races during in play then you should monitor only one 

market at a time and get highest refresh rate. When monitoring multiple markets at same time 

then actual refresh rate is lower, because maximum number of requests to get market prices 

per minute is 60, so bot monitors selected markets in circle which results in lower refresh rate 

 “In grid only display data that is collected before in play” – if ticked then information in grid will 

be updated only from market prices that are collected before in play 

 “Stop monitoring market if it does not go in play for X minutes after official start time” – actual 

start of some markets can be delayed by 10, 20 or more minutes because of bad weather or 

some other reasons and this can affect the way bot works e.g. bot could be waiting for market 

to start and miss betting on other markets that start on time. In such cases you can use this 

setting to skip that market and go on monitoring next market in grid. 

 “Remove markets from grid X hours after start time” – markets will be removed from main 

markets data grid view X hours after their start time. This is useful when betting on many 

markets or different events. 

 “At in play remove markets whose matched amount is less than X” – markets that have total 

matched amount less than X will be removed from main markets data grid view and will not be 

monitored during in play, so bot will not bet on them. This is useful when you are monitoring 

large number of markets and want to minimize this number by removing markets that have low 

traded volume. 

 “At in play remove markets that do not have any bets” – markets on which bets were not placed 

before in play will be removed from main markets data grid view and will not be monitored 

during in play, so bot will not be on them.  

 “Remove closed markets after X minutes” – markets that have Closed status will be removed X 

minutes after changing their status to Closed 

 “Display full market name and path in grid” will display complete market path in events tree for 

each market. This can have large effect on market filters when selecting/deselecting markets 

and allowing bot to bet on markets that have specified text in their name. It can be very useful 



 

21 
  

©2008-2015 http://www.bfbotmanager.com 

when you want to have one strategy with Multiple Strategies bot for betting on Premier League 

and another one betting on Bundesliga matches because market filters check market name from 

main markets data grid view column “Market name”. 

4.3 Add Markets 
 

 Add markets form is used to add any Betfair market to the markets data grid view that cannot 

be loaded automatically by bot. Once market gets added to the markets data grid view it will be 

monitored and bot will be able to place bets on it if needed. 

 To add manually markets user needs to use add markets form, displayed on Image 18, and to 

navigate to the market that needs to be added to the grid. Markets that are already in grid cannot be 

added again, clicking on such market in add markets form will do nothing. If user clicks on market that is 

not in grid then that market will automatically be added in background to the grid. 
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Image 18 

 

 

4.4 Filters 
 

 Most bots have options to automatically load all races for selected country, but if we want to 

filter races by their name and type then we need to use “Markets Filtering Form”. On Image 19 we can 

see “Markets Filtering Form” and its options. Filters simply select or deselect markets by using “S.” 

column in grid. 

 In filter textboxes it is possible to specify CSV (Comma Separated Values) list of values that 

market name must or must not contain. In example on Image 19 we can see that markets will be 
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deselected by default when they are loaded to the grid and only markets that have in their name text 

“Hcap” or “Mdn” will be selected. 

 It is also possible to specify time range and select markets within that time range. After setting 

all filters user should click “Apply Filter Now” button to apply selected filters to already loaded markets, 

while filters will be automatically applied to new markets that get added to the grid. 

 

Image 19 

 

 

4.5 Import 
 

 Import functionality can be used to import selections that were saved by using “Export My 

Favorites – Fav” context menu item or for importing CSV file that was generated by tipster service or 

some other prediction software. 

 All runners that are loaded from import file will be searched within existing loaded markets and 

if they are found then “Fav.” checkbox at “Selections Form” will be ticked making them as user favorites. 

Their names will be displayed in “1st Favorite” column in grid and colored in red. 

 Import file can contain multiple selections per market and on Image 20 we can see details about 

import file format. Selections are searched by market start time and their name, so it is important that 

those details are accurate. 
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 By default import considers that time is in UTC format in import file, but it is possible to import 

file that contains your local times in which case you must make sure that your local PC time is the same 

as local time used in import file. 

Image 20 

 

 

 If you are subscribed to The BetPlan tipping service then at following form you can enter your 

registered The BetPlan email addres and bot will automatically download tips from them and import 

them. 

 If you running bot 24 hours a day, then you can also tick option to automatically download and 

import The BetPlan selections each day. In combination with “auto reload” option from auto load 

markets form you will be able to leave bot running for days unattended. This is recommended only for 

experienced users that run their bots on reliable VPS servers. 

 If you are not subscribed to The BetPlan then you can do it by clicking here The BetPlan. 

http://thebetplan.com/promotions/idevaffiliate.php?id=292
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Image 21 
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5. Resources 
 

Manuals for bots 

http://www.bfbotmanager.com/cgi-bin/bots.pl 

FAQ page 

http://www.bfbotmanager.com/cgi-bin/faq.pl 

Bf Bot Manager Forum 

http://www.bfbotmanager.com/phpbb3/index.php 

Request Trial 

http://www.bfbotmanager.com/cgi-bin/trial.pl 

Download & Buy 

http://www.bfbotmanager.com/cgi-bin/buy.pl 

Contact 

http://www.bfbotmanager.com/cgi-bin/contact.pl 

Link to register at Betfair for free bonus bet 

http://ads.betfair.com/redirect.aspx?pid=18688&bid=4186 
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